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What's New

The changes linked to new features in version 4.0. are listed in the table below.

In the the icon has been added in the left margin to highlight information on new and
updated features.

Click the section number in the table to jump directly to the corresponding section.

Section Description

3.3.10, 3.3.11, HSMs are configured in a separate tab. DIVA host, port, login and
password can be edited.
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1. Introduction

1.1. About the Application

IP2Archive Tape Storage Controller is an automated application or robot that interacts
with the hierarchical storagemanagement system to drive all the archive, (partial) restore
and purge requests originating from IPDirector and the IP2Archive Deep Archive
Manager.
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2. Starting the Application

2.1. Start-up Procedure

2.1.1. After Installation

Double-click the IP2Archive Tape Storage Controller icon on the desktop of the
application server to start the application. You can also start the application by double-
clicking the executable file (.exe) in the installation folder.

The splash screen appears.

The application logs into the database. Then, the Settings window appears allowing you to
configure the application.

See section "Settings Window" on page 6.

2.1.2. After Configuration

Double-click the IP2Archive Tape Storage Controller icon on the desktop of the
application server to start the application. You can also start the application by double-
clicking the executable file (.exe) in the installation folder.

The splash screen appears. The application logs into the database.

Then, themain window opens. After a time interval defined in the settings, the application
automatically starts performing its various tasks.

2 2. Starting the Application
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2.2. Main Window Overview

Themajor areas of themain window are highlighted in the screenshot below.

(1) Menu Bar

Themenu bar contains threemenus: File, Settings and Help.

The File menu contains only one command: Exit. It is used to exit the application. Click
the File menu or use the keyboard shortcut keys ALT + F or F10 + F to open it. Click Exit
or use the keyboard shortcut key X to exit the application.

The Settings menu doesn’t contain any commands. It immediately gives access to the
application settings. Click the Settings menu or use the keyboard shortcut keys ALT + S
or F10 + S to access the settings.

The Help menu contains only one command: About. With this command the application
splash screen can be opened. The splash screen displays the application software
version, the name of the database the application is logged on to and the login name used.
Click the Help menu or use the keyboard shortcut keys ALT + H or F10 + H to open it.
Click About or use the keyboard shortcut key A to open the splash screen.

Thesemenus only become available after you have clicked the Stop button.

(2) Tasks Pane

The Tasks pane displays the number, name and description of the tasks performed by the
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application. Only the tasks that were activated in the System settings will be performed at
start-up. If you want to manually run certain tasks for test purposes, you have to stop the
application, select the corresponding check box in the Active column, and then click the
Start button. This button only becomes available after you have clicked the Stop button.

See section "Tasks Tab" on page 15.

(3) Start/Stop Buttons

These buttons are used tomanually start and stop the application.

(4) Log Pane

The Log pane lists application events and can be useful when you are trying to verify that
automations are working correctly. The date and time of each event is displayed.

4 2. Starting the Application
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2.3. Overview Tasks Tape Storage Controller

The table below gives a brief description of the tasks performed by IP2Archive Tape
Storage Controller.

Number Task Description

1 Synchronize
Database

When interfacing with Front Porch Digital Archive
Searches in the DIVArchive database for the number of
groups and LTO tapes present in the LTO tape library and
synchronizes this with the IP2Archive database.

2 Request
Backup

When interfacing with Front Porch Digital Archive
Checks the IP2Archive database for archive requests and
commands the DIVA Manager to start the archiving process.

3 Request
Restore

When interfacing with Front Porch Digital Archive
Checks the IP2Archive database for restore requests and
commands the DIVA Manager to start the restore process.

4 Request
Purge

When interfacing with Front Porch Digital Archive
Checks the IP2Archive database for purge requests and
commands the DIVA Manager to start the purge process.

5 Synchronize
Database

When interfacing with Front Porch Digital Archive
Searches in the DIVArchive database for the number of
groups and LTO tapes present in the LTO tape library and
synchronizes this with the IP2Archive database.

6 Update
Backup
Progress

When interfacing with Front Porch Digital Archive
Checks the status and progress of the archive jobs and
synchronizes this information with the IP2Archive database.

7 Update
Restore
Progress

When interfacing with Front Porch Digital Archive
Checks the status and progress of the restore jobs and
synchronizes this information with the IP2Archive database.

8 Update
Purge
Progress

When interfacing with Front Porch Digital Archive
Checks the status and progress of the purge jobs and
synchronizes this information with the IP2Archive database.

Note
For performance reasons, two or more instances of the Tape Storage Controller
can be installed. Each instance can be configured to perform only a specif set of
the tasks mentioned above. For example, there could be an instance that only
performs the archive and purge tasks, and an instance that only performs the
restore tasks.
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3. Configuring the Application

3.1. Settings Window

3.1.1. Opening the Settings Window
The Settings window allows you to configure your application. The first time the
application is launched after it has been installed, the Settings window opens
automatically.

The Settings window can also be accessed through the Settings menu. Tomake this
menu available, click the Stop button. The application will stop performing its tasks.

6 3. Configuring the Application
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3.1.2. Overview Setup Categories
The settings can be divided into three setup categories. In the Settings window, a tab is
provided for each setup category. The table below briefly describes each setup category:

Setup Category Description

User Settings These settings can be configured by each individual user.

Global Settings These settings can only be configured by the system
administrator and by an eventual superuser.

System Settings These settings configure the general functioning of the
application. They can only be configured by the system
administrator.

Currently, only the User Settings and System Settings tab contain settings. TheGlobal
Settings tab is still empty. It does not contain any settings.

3.1.3. Edit Mode
To be able to edit the Global and System settings, you first have to enter a password.

To put the Settings window into Edit Mode, proceed as follows:

1. Click the Enter Into Edit Mode button .

A dialog box appears.

2. Enter the administrator password and then click OK.

The Settings window enters into Edit Mode.

3.2. User Settings

3.2.1. Accessing the User Settings
The User settings can be accessed by clicking the User Settings tab in the Settings
window.

3.2.2. Overview User Settings Subcategories
The User settings are divided into the following subcategories:
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• MAD

For each subcategory a tab is provided.

3.2.3. MAD Tab
If you select the check box If Video File Is Not Found, Search in Paths, you can add
one or more paths of storage folders the HSM system has to look for video files, if it does
not find them on the nearline storage.

In theMaximum Requests field you can enter themaximum number of archive or restore
requests that can simultaneously be processed by the HSM system. The HSM system
will wait until one of these requests has been processed before starting a new request.

3.3. System Settings

3.3.1. Accessing the System Settings
The System settings can be accessed by clicking the System Settings tab in the Settings
window.

3.3.2. Overview System Settings Subcategories
The System settings are divided into the following subcategories:

• Directories

• MAD Options

• Oracle Connection

• E-Mail Options

• Timers

• Tasks

• Global Password

• Error Handling

8 3. Configuring the Application
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• HSMs

• DIVA

For each subcategory a tab is provided. The Directories tab is empty. It doesn't contain
any settings.

3.3.3. MAD Options Tab
TheMAD Options tab allows you to configure the log file management, and the archive
and restore process.

Configuring the Archive Process

If the setting Smart Sort Requests by Group is enabled, IP2Archive Tape Storage
Controller will commandDIVArchiveManager to sort all archive requests by group. When
requests of the same group are processed sequentially, the tape robot won’t have to
change tapes that often. However, the priority level of the files won’t be considered then.
This setting can be disabled in case there aremultiple DIVArchive actors and requests of
different groups can be processed simultaneously.

If the setting Do Not Archive to Empty Tape If There Is an Ejected Tape With Space
Left is enabled, IP2Archive Tape Storage Controller will command the hierarchical
storagemanagement system to first check the LTO tape library for ejected tapes with
space left before archiving files. If there are ejected tapes with space left, the hierarchical
storagemanagement system will wait until one of these tapes is available again in the
LTO tape library to archive the files. If there are no ejected tapes with space left, the files
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will be archived to an empty tape that is present in the LTO tape library. If this setting is
disabled, this check is not performed.

If the settingMark File as ‘Archived’ Only After It Has Been Written to Tape is
enabled, IP2Archive Tape Storage Controller will wait to mark a file as being archived in
the IP2Archive database until the file has been written to LTO tape. In the Deep Archive
Manager GUI the file will then bemoved to the Archived tab only after the file has been
written to LTO tape.

If the setting Check if Source File Exists is enabled, IP2Archive Tape Storage Controller
will first check if the file to be archived really exists. If the file doesn't exist, it will not start
the archive process. Clear this setting if Tape Storage Controller has no access to the
storage location of the source file.

If the setting Archive EVS Metadata XML File If Present is selected, IP2Archive Tape
Storage Controller will command the hierarchical storagemanagement system to also
archive the EVS metadata XML file. In the Extension field you have to enter the default
extension of the EVS metadata XML file, i.e. .evs.xml. This will prevent the hierarchical
storagemanagement system from archiving other types of XML files.

If the setting Report Error If Metadata File Does Not Exist is not selected and no
metadata file is found, only the video file is archived. If the setting is selected and no
metadata file is found, the archive process will go into error.

Configuring the Restore Process

If the setting Smart Sort Requests by Group is enabled, IP2Archive Tape Storage
Controller will commandDIVArchiveManager to sort all restore requests by group. When
requests of the same group are processed sequentially, the tape robot won’t have to
change tapes that often. However, the priority level of the files won’t be considered then.
This setting can be disabled in case there aremultiple DIVArchive actors and requests of
different groups can be processed simultaneously.

Configuring Log File Management

To be able to configure the log file management, you have to select the Log Files check
box.

In the Directory field you can enter the path of the log storage directory or you can browse
for it by clicking . If you leave this field empty, the application will automatically create
a default directory: C:\EVSLogs\MAD\[Application name].

If the A New Log Every Day check box is selected, a new log is started every day.

You can also specify a time interval (in days) after which the logs should be removed from
the log storage directory. If you enter ‘-1’, the logs are never removed from the storage
directory.

Configuring LogMemo Size

In the LogMemo group box you can specify themaximum number of lines retained by the
Log pane.

10 3. Configuring the Application
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3.3.4. Oracle Connection Tab
TheOracle Connection tab allows you to configure the connection with the Oracle
database.

Entering the Database Name

In this field you have to enter the name of the database the application has to connect to.

If the Use This Database Name check box is selected, the name of the database will
automatically appear in the Oracle login dialog box at start-up.

Entering the Login Name

In this field you have to enter a login name. If the Use This Login Name check box is
selected, the login namewill automatically appear in the Oracle login dialog box at start-
up.

Entering a Password

In this field you have to enter a password. If the Use Auto Login check box is selected,
the application automatically logs into the selected database at start-up. TheOracle login
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dialog box does not appear.

Activating Version Control

If the Use Version Control check box is selected, the software version of the application
is checked each time it logs into the database. This check box should always be
selected!!

If the software version is outdated, the following warningmessage appears in the splash
screen highlighted in red: ‘Obsolete – A newer version exists. May not be used anymore.’

Click the OK button to close the splash screen and update your software version.

By clicking the Application History button, you can open a chronological list of all
software versions of the application. To get more details about each version (creation
date, name of programmer, status, additional remarks), you have to click + next to the
version number.

Activating Keep Alive

If the option Keep Connection Alive is selected, amessage is sent to the database at
regular time intervals to avoid idle connections from being closed by the firewall. These
intervals can be set by you.

If the option Try to Reconnect if Keep Alive Fails is selected, the application will try a
number of times to reconnect with the database.

If the option Report Status in Database Everytime Keep Alive Timer Triggers is
selected, the status of the connection is reported in the database each time the Keep
Alive Timer sends a trigger to send a Keep Connection Alivemessage.

If the option Report Status of Tasks is selected, the status of the tasks (ok or not ok) is
reported to the database.

Testing the Oracle Connection

The Test Oracle button allows you to check the validity of the database name, login and
username you entered.

If these data are valid, then the followingmessage appears next to the Test Oracle
button: ‘OK’.

If the login name or password is invalid, then amessage box appears with the following
message: ‘ORA-01017: invalid username/password; logon denied’.

If the database name is invalid, then amessage box appears with the followingmessage:
‘ORA-12154:TNS: could not resolve the connect identifier specified’.

If you omit the password, then amessage box appears with the followingmessage:
‘ORA-01005: null password given; logon denied’.

If you don’t enter a database name, login and username, then amessage box appears
with the followingmessage: ‘ORA-12560: TNS: protocol adapter error’.

If the Use Version Control check box is selected, you can also check the software
version of the application by clicking the Test Oracle button. If the software version is up-
to-date, then the followingmessage appears: ‘Actual – The Actual Version’. If the software
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version is outdated, then the followingmessage appears: ‘Unknown Version Application!
Please contact the EDP department.’

If you close the Settings window without testing the validity of the database name, login
and username you just entered, then amessage box appears.

If you click Yes, then the Settings window is closed and the original values are restored. If
you click Cancel, then the Settings window doesn’t close and you can test the values by
clicking the Test Oracle button.

If you change the current database settings, test the connection and then close the
Settings window, amessage box will appear.

If you click Yes, the application is stopped and closed. A manual restart will be required.
Click Cancel to continue.

3.3.5. E-Mail Options Tab
The E-Mail Options tab allows you to configure an e-mail account enabling the application
to e-mail error notifications to the EVS developers.
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To be able to configure the e-mail account, you have to select the Send E-Mail check
box. The fields in theMail System Settings andMail Message Settings group box become
available.

Configuring an E-Mail Account

In theMail System Settings group box you have to enter the IP address and port number
of the SMTP server and specify a timeout. In the SMTP Login group box you can enter a
username and password.

Configuring a Default E-Mail Message

TheMail Message Settings group box contains two tabs: Internal Mail Settings and
External Mail Settings.

The Internal Mail Settings tab is used to configure a default e-mail message that will be
sent to the EVS developers when an error occurs.

The External Mail Settings tab is used to configure a default e-mail message that will be
sent to the customer to notify him about an error. In each tab you have to enter the
sender’s email address, the email address of the various recipients and a subject.

To test the settings andmanually send an e-mail message, click the Send Mail button.

14 3. Configuring the Application
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3.3.6. Timers Tab
The Timers tab allows you to set time intervals for some automated tasks.

Configuring Auto-Start

In the Auto Start group box you can specify the time interval after which the application
automatically starts performing its tasks.

Setting Time Interval Between Tasks

In the Perform Tasks group box you can specify the length of the time interval (in
seconds) between two subsequent tasks.

3.3.7. Tasks Tab
The Tasks tab gives an overview of the active tasks.

In the Active by Default column you can activate the tasks that must be performed by
default at start-up. The Active column displays the tasks that are currently selected in the
main window. By default, all tasks are selected in both columns.

3.3.8. Global Password Tab
TheGlobal Password tab allows you to set a password that the superuser(s) has/have to
enter to be able to edit the Global settings of the application, if any. To apply the
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password, you have to click the Apply button.

3.3.9. Error Handling Tab
The Error Handling tab is used to configure the error handling by the application. This tab
will only be used by the EVS administrator.

Handling Unhandled Errors

If the Save the Screen Dump check box is selected, a screenshot is taken of an
unhandled error message and stored in the database and in a folder on the computer
where the application is installed. In the Not Logged Error(s) pane, errors can be typed for
which no log was created. By default, this check box is selected.

16 3. Configuring the Application
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Handling Handled Errors

If the Save the Unforced Error Log’s check box is selected, the log of the error is saved
in the database and in a folder on the computer where the application is installed. By
default, this check box is selected.

If the Save the Screendump check box is selected, a screenshot is taken of the error
message and stored in the database and saved in the same folder as where the error log is
kept. By default, this check box is selected.

3.3.10. HSMs Tab
The HSMs tab is used to configure the communication with the hierarchical storage
management system. The data entered here will be automatically entered in the tab in the
System settings corresponding to the hierarchical storagemanagement system.

How to Configure the Communication with a HSM System

To configure the communication with a HSM system, proceed as follows:

1. In the Type column, select the type of HSM system Tape Storage Controller has to
communicate with.

2. In the Name field, enter the name of the DIVA manager.

3. In the Address field, enter the IP address of the DIVA manager.

4. In the Port field, enter the port number of the DIVA manager.

5. Click outside the record.
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The Post button becomes available .

6. Click the Post button to validate the settings.

7. Click the Save button to save the settings or Undo to undo the settings.

Depending on the type of HSM you have selected, the DIVA tab will become
available.

3.3.11. DIVA Tab
The DIVA tab contains the settings used to configure the communication with the
DIVArchive system and the archive and restore process. This tab only becomes available
if you have chosen DIVA as HSM type in the HSMs tab. See section "HSMs Tab" on
page 17.

Configuring the Connection With DIVA

In the Connection group box the following data is automatically entered:

• Name of the DIVArchiveManager. The DIVArchiveManager is themain component
in a DIVArchive system. All archive operations are controlled and handled by the
DIVArchiveManager.

• IP Address of themanagement station running the DIVArchiveManager software
component.

18 3. Configuring the Application
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• Listening port number of the DIVArchiveManager management station.

This data originates from the HSMs tab. See section "HSMs Tab" on page 17. The
following field has to be enteredmanually:

• Default Set ID. The tapes in the library are initially divided into sets, and are assigned
a number called a Set ID. Set ID’s allow to partition pools of tapes in a library and
assign them for use with specific DIVArchive groups.

A Test button allows you to test the connection with DIVArchive. If the connection is ok,
themessage ‘Success’ will appear.

If you are already connected, an error message will appear.

Configuring the Archive Process

The Archive group box contains settings used to configure the archive process.

The Source field contains the name of the system that has content intended to be
transferred to DIVArchive, i.e. the nearline storage. This name is pre-defined in the
DIVArchive source configuration.

TheQuality of Service (QOS) parameter defines how a file is to be transferred to a
DIVArchive tape.

The options for QOS are defined as follows:

• Direct Only: Thematerial is written to tape immediately as it is being transferred from
a destination. If no direct transfer service is available, the request will be aborted.

• Cache Only: Thematerial is first transferred entirely from the source to cache
storage, and then written to tape. If no cache service is available, the request will be
aborted.

• Direct and Cache: If a direct transfer is not available (e.g. no Actor with direct
transfer enabled is available), then cache transfer will be used instead.

• Cache and Direct: If cache transfer is not available (e.g. no Actor with cache storage
is available), a direct transfer will be performed instead.

• Default: TheQOS specified in the source configuration will be used.

By default, the option Cache and Direct is selected.

TheOptions field contains additional options that must be used for performing the transfer
of data from the source to DIVA. These options supersede any options specified in the
DIVA configuration database. Currently the possible values are:

A null string to specify no options
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• -r: Specifies that every name in filenamesList that refers to a directory must be scanned
recursively. This also applies when a file path root is specified and ‘*’ is used to designate
the file(s) to be archived. This optionmay be used when archiving from a local source or
from a standard FTP server.

• -login login used for some sources.

• -pass password in conjunction with the –login option for some sources.

Configuring the Restore Process

The Restore group box contains settings used to configure the restore process.

The Destination field contains the name of the system that requires content to be
transferred to it from DIVArchive. This name is pre-defined in the DIVArchive destination
configuration.

TheQuality of Service (QOS) parameter defines how a file is to be transferred from a
DIVArchive tape to a destination.

The options for QOS are defined as follows:

• Direct Only: Thematerial is transferred immediately to the source as it is being read.
If no direct transfer service is available, the request will be aborted.

• Cache Only: Thematerial is first transferred entirely to cache storage from tape, and
then transferred to the destination. If no cache service is available, the request will be
aborted.

• Direct and Cache: If a direct transfer is not available (e.g. no Actor with direct
transfer enabled is available), then cache transfer will be used instead.

• Cache and Direct: If cache transfer is not available (e.g. no Actor with cache storage
is available), a direct transfer will be performed instead.

• Default: TheQOS specified in the destinations configuration will be used.

The following additional services are available:

• Default: Operate as per default setting in theManager configuration;

• Do Not Overwrite: Do not overwrite existing files on the destination server.

• Do Not Check Existence: Do not check the existence of the clip on the server.

• Delete and Write: Force delete and rewrite if object exists on server.

TheOptions field contains aditional options that must be used for performing the transfer
of data from DIVA to the destination. These options supersede any options specified in
the DIVA configuration database. Currently the possible values are:

• A null string to specify no options

• -login login used for some sources.

• -pass password in conjunction with the –login option for some sources.
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